IBM Tivoli NetView for UNIX

Release Notes

Version 7.1.2

May 6, 2002
Contents

Introduction .................................................................................................................. 7
New Features and Enhancements ................................................................................ 7
Enhanced IBM Tivoli Enterprise Console Integration .............................................. 7
Installation and Configuration Considerations ....................................................... 8
New Options to the instalnv Script ........................................................................ 9
Using the nvits_config Script ............................................................................. 10
Using the tecits_upgrade Script to Upgrade to New Event Class Structure .......... 12
Installing IBM Tivoli Switch Analyzer Rules on IBM Tivoli Enterprise Console Server ... 13
IBM Tivoli Enterprise Console Server Compatibility ............................................ 14
New Variable Bindings for NetView Traps .............................................................. 14
New NetView Traps .................................................................................................. 15
Web MIB Browser Enhancements ......................................................................... 16
Web Console Security Enhancement ..................................................................... 17
Passwords ................................................................................................................ 17
Web Console Enhancements ..................................................................................... 17
Submap Explorer .................................................................................................... 17
Object Properties .................................................................................................... 18
Diagnostics: QuickTest and QuickTest Critical .................................................... 18
Router Fault Isolation (RFI) Enhancements ............................................................ 19
Subnets with Routers – suppress all node downs. .................................................. 19
Subnets with some routers known ......................................................................... 19
Subnets with no routers ........................................................................................ 19
RFI Configuration .................................................................................................. 20
New netmon.conf Configuration File ................................................................... 20
Status Update Request ............................................................................................ 21
Contents

nvmaputil Command Line Interface (CLI) Utility ................................................................. 21
Other Enhancements ......................................................................................................... 22
  Cisco Devices SmartSet ............................................................................................... 22
  Updates to oid_to_type .............................................................................................. 22
  SNMP Collections ....................................................................................................... 22
  Layer 2 Analysis Option Added to ovtopodump Utility ........................................... 22
  Java Runtime Environments ....................................................................................... 23
Supported Platforms ........................................................................................................ 23
System Requirements ..................................................................................................... 23
  Upgrade Restriction ..................................................................................................... 23
  Linux Hardware Prerequisites .................................................................................. 23
  Linux Software Prerequisites ................................................................................... 24
  AIX Software Prerequisites ...................................................................................... 24
Patches Required for this Release ................................................................................... 24
Installation Notes ........................................................................................................... 24
  Linux Intel Installation ............................................................................................... 25
Deprecated ....................................................................................................................... 26
Defects Fixed in this Release .......................................................................................... 26
  Abstract of Version 7.1.2 Fixes .............................................................................. 26
  Abstract of Version 7.1.1 Fixes .............................................................................. 27
Known Limitations ........................................................................................................... 29
Documentation Changes ................................................................................................. 32
Product Notes ................................................................................................................. 40
Installing and Using the IBM Tivoli NetView Language Kits ........................................ 44
  Supported Languages: ............................................................................................... 44
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Requirements</td>
<td>45</td>
</tr>
<tr>
<td>Installing the Tivoli NetView Language Kits</td>
<td>45</td>
</tr>
<tr>
<td>LANG and LC_ALL Environment Variable Settings</td>
<td>48</td>
</tr>
<tr>
<td>Upgrading from a Previous Tivoli NetView Language Kit</td>
<td>48</td>
</tr>
<tr>
<td>Migrating Security Files</td>
<td>48</td>
</tr>
<tr>
<td>If NetView Applications or Web Consoles Display in English</td>
<td>49</td>
</tr>
<tr>
<td>Installation Utility Scripts</td>
<td>51</td>
</tr>
<tr>
<td>Language Kit Restrictions</td>
<td>51</td>
</tr>
<tr>
<td>Translation Support</td>
<td>52</td>
</tr>
<tr>
<td>Language Kit Notes</td>
<td>53</td>
</tr>
<tr>
<td>Appendix A: Event Mapping and New Class Structure</td>
<td>57</td>
</tr>
<tr>
<td>Appendix B: nvmaputil Utility</td>
<td>61</td>
</tr>
</tbody>
</table>
Introduction

This Release Notes document provides important information about Version 7.1.2 of the IBM Tivoli® NetView® program. These notes are the most current information for the product and take precedence over all other documentation.

This document, together with the Tivoli NetView Release Notes Version 7.1, and the Tivoli NetView for UNIX Configuration Guide, Version 7.1, provides all of the necessary information for planning and performing the installation of IBM Tivoli NetView for UNIX Version 7.1.2. Please review these notes thoroughly before installing or using this product.

Please note that the version of IBM Tivoli NetView described in this document is both a complete new installation and an upgrade to IBM Tivoli NetView Version 7.1 and Version 7.1.1, and all information contained in the IBM Tivoli NetView Release Notes Version 7.1 also applies to IBM Tivoli NetView Version 7.1.2 unless otherwise noted in this document.

New Features and Enhancements

Enhanced IBM Tivoli Enterprise Console Integration

The integration between IBM Tivoli NetView and IBM Tivoli Enterprise Console has been enhanced to provide automatic event correlation for a default set of finely-tuned network events. This will dramatically improve the ability of event console operators to find the root cause of network-related problems, as well as provide automatic housekeeping by clearing obsolete network status events.

In order to take advantage of this enhanced integration, IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 or later is required. See the nvintegration.pdf file provided with IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 for details about the enhanced integration.

NOTE: Sections 4.2 and 4.2.2 in the nvintegration.pdf document incorrectly state that closed events are synchronized with IBM Tivoli NetView. Version 3.7.1 Fixpack 02 supports synchronization only of acknowledged events.
IBM Tivoli NetView provides a default set of significant events that will be forwarded to the IBM Tivoli Enterprise Console including status events, selected SNMP data collection threshold events, and Router Fault Isolation events. Refer to Table 1 in Appendix A: Event Mapping and New Class Structure table for the complete list of events that are forwarded by default.

The event class structure has been modified, including some slot mappings, for IBM Tivoli NetView events that are sent to the IBM Tivoli Enterprise Console. All classes in the new event class structure begin with the prefix "TEC_ITS" instead of "OV". Refer to Table 2 in Appendix A: Event Mapping and New Class Structure for mapping of IBM Tivoli NetView events to the new TEC_ITS classes that are not forwarded by default.

A new NetView ruleset and baroc file are included with IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02. This ruleset provides special event correlation for the new TEC_ITS events. The NetView ruleset is added to the Default rule base by the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 installation, but is not active by default. Refer to the "IBM Tivoli NetView Integration" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README file for the steps required to activate the NetView ruleset. Please refer to the "Known Defects and Limitations" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README. This file it describes the current limitations of the NetView ruleset.

Customers upgrading from a previous version of IBM Tivoli NetView may continue to use the old "OV" class structure in order to preserve their own custom rules, but they will not be able to take advantage of the enhanced integration capabilities provided by the new event class structure and rules. Customers can choose to upgrade at any time after an upgrade installation using the `tecits_upgrade` script described below.

**Installation and Configuration Considerations**

The following scripts allow you to easily configure integration with the IBM Tivoli Enterprise Console Server during or after installing IBM Tivoli NetView.

- The new options to the `installnv` script allow you to configure event forwarding to an IBM Tivoli Enterprise Console Server during the installation.
• Run the `nvits_config` script to configure event forwarding to an IBM Tivoli Enterprise Console Server after a fresh installation using the Tivoli Framework.

• The `tecits_upgrade` script allows you to upgrade to the new TEC_ITS event class structure at any time after an IBM Tivoli NetView upgrade installation.

New Options to the `instalnv` Script

During a fresh installation of IBM Tivoli NetView 7.1.2, users have the option of configuring events to be forwarded to an IBM Tivoli Enterprise Console Server.

This section describes the new installation options that have been added to the `instalnv` script. These options can be used to configure event forwarding to the IBM Tivoli Enterprise Console during the installation of IBM Tivoli NetView. These options can be used only during a fresh installation.

Usage:

`instalnv -k KIT [-d b/a/l] [-c "name1 name2 name3"] [-t serverName [-p port] [-w] [-h]]`

Where:

`-k KIT` specifies the kit to install:
SERVER, CLIENT, BOOKS
Note that CLIENT is not available on Linux.

`-d b/a/l` specifies the discovery mode: "b" for Backbone-only, "a" for All Networks, or "l" for Local Subnet Only. This parameter is optional. The default is "Local Subnet Only".

`-c "name1 name2 name3"` specifies a list of up to six community names used for network discovery. The community names must be separated by spaces and enclosed by quotes. This parameter is optional but if it is not specified, discovery may be limited if community names other than "public" are in use.

`-t serverName` is the name of the IBM Tivoli Enterprise Console Server to which events are being forwarded. This parameter is optional.
-p port specifies the port to be used for communication with the IBM Tivoli Enterprise Console Server. This parameter is optional. It is necessary to specify this parameter only if the port has been customized, otherwise the default (5529 for a Windows IBM Tivoli Enterprise Console Server, 0 for a Unix IBM Tivoli Enterprise Console Server) will be used.

-w indicates that the IBM Tivoli Enterprise Console Server specified with the -t option is a Microsoft Windows machine. This option must be specified for a Windows IBM Tivoli Enterprise Console Server, otherwise the port will not be configured correctly.

-h Displays the usage statement.

This script does the following:

- Turns on event forwarding to the specified IBM Tivoli Enterprise Console Server.
- Sets the discovery mode as specified. The default is "Local Subnet Only".
- Adds the specified list of Alternate Community Names (-c "name1 name2 name3") to the /usr/OV/conf/communityNames.conf file.

Using the nvits_config Script

The nvits_config script should be run on the IBM Tivoli NetView server machine after a fresh installation only of IBM Tivoli NetView for UNIX using the Tivoli Framework installation method. This script does not need to be run if the instalnv script was used to install IBM Tivoli NetView. This script is provided to allow out-of-the-box configuration of IBM Tivoli NetView with an IBM Tivoli Enterprise Console Server.

/usr/OV/bin/nvits_config [-t serverName [-w] [-p port]] [-c "name1 name2 name3"] [-d b/a/l] [-h]

Where:

-t serverName is the name of the IBM Tivoli Enterprise Console Server to which events are being forwarded. This parameter is optional.
-w indicates that the IBM Tivoli Enterprise Console Server specified with the -t option is a Microsoft Windows machine. This option must be specified for a Windows IBM Tivoli Enterprise Console Server, otherwise the port will not be configured correctly.

-p port specifies the port to be used for communication with the IBM Tivoli Enterprise Console Server. This parameter is optional. It is necessary to specify this parameter only if the port has been customized, otherwise the default (5529 for a Windows IBM Tivoli Enterprise Console Server, 0 for a Unix IBM Tivoli Enterprise Console Server) will be used.

-c "name1 name2 name3" specifies a list of up to six community names used for network discovery. The community names must be separated by spaces and enclosed by quotes. This parameter is optional but if it is not specified discovery may be limited if community names other than "public" are in use.

-d b/a/l specifies the discovery mode: "b" for Backbone-only, "a" for All Networks, or "l" for Local Subnet Only. This parameter is optional. The default is "Local Subnet Only".

-h Displays the usage statement.

This script does the following:

- Turns on event forwarding to the specified IBM Tivoli Enterprise Console Server.

- Sets the discovery mode as specified. The default is "Local Subnet Only". NOTE: This option clears the databases and restarts discovery. Do not use this script after an upgrade installation.

- Adds the specified list of Alternate Community Names (-c "name1 name2 name3") to the /usr/OV/conf/communityNames.conf file.
Using the tecits_upgrade Script to Upgrade to New Event Class Structure

During an upgrade installation of IBM Tivoli NetView 7.1.2, the old "OV" class structure and all user customizations for the IBM Tivoli Enterprise Console are preserved. Customers can continue to use their custom rules with the old class structure, if desired.

At any time after an upgrade installation (using either the Tivoli Framework or using the -u option of the non-Framework instalnv script), you can use the tecits_upgrade script to upgrade to the new TEC_ITS event class structure.

Usage:

/usr/OPV/bin/tecits_upgrade [-s serverName] [-p port] [-w] [-h]

Where:

-s serverName is the name of the IBM Tivoli Enterprise Console Server to which events are being forwarded. This parameter is not necessary unless you have never configured event forwarding to an IBM Tivoli Enterprise Console Server.

-p port specifies the port to be used for communication with the IBM Tivoli Enterprise Console Server. This parameter is optional. It is necessary to specify this parameter only if the port has been customized, otherwise the default (5529 for a Windows IBM Tivoli Enterprise Console Server, 0 for a Unix IBM Tivoli Enterprise Console Server) will be used. This parameter is not necessary unless you have never configured event forwarding to an IBM Tivoli Enterprise Console Server.

-w indicates that the IBM Tivoli Enterprise Console Server specified with the -s option is a Microsoft Windows machine. This option must be specified for a Windows IBM Tivoli Enterprise Console Server, otherwise the port will not be configured correctly.

This parameter is not necessary unless you have never configured event forwarding to an IBM Tivoli Enterprise Console Server.

-h Displays the usage statement.
The TEC_ITS upgrade script does the following:

- Backs up the current trapd.conf file.
- Upgrades traps to the new TEC_ITS class structure including new slot mappings for some events.
- Updates the tecint.conf file (if it exists) to use the new TEC_ITS ruleset and class structure. If the tecint.conf file does not exist, and you have not specified the IBM Tivoli Enterprise Console Server information with the \(-s\) (and possibly \(-w\) and \(-p\)) options, you are prompted for the IBM Tivoli Enterprise Console Server name and related information.
- Sets the NVMAPGLOBALACK environment variable to 1. This is required in order for the Acknowledge function to work from the IBM Tivoli enterprise Console. It will change the default behavior of Acknowledge to use “global-based” mode. When global-based mode is set, the Acknowledged status is an object attribute. All NetView clients are notified when an object is acknowledged or unacknowledged immediately, regardless of which map is open and even if the action is performed on a read-only map.
- Creates a new "CiscoDevices" SmartSet.
- Adds the "Bandwidth Utilization for Routers" and "CPU Utilization for Cisco Devices" SNMP data collections.

**Installing IBM Tivoli Switch Analyzer Rules on IBM Tivoli Enterprise Console Server**

If you are using the optional IBM Tivoli Switch Analyzer, you should upgrade the Default rule base on the IBM Tivoli Enterprise Console Server to take advantage of new rules to correlate IBM Tivoli Switch Analyzer events. These new rules are included in the `netview.rls` file located in the TEC directory of the IBM Tivoli NetView 7.1.2 CD.

The TEC directory contains the new `netview.rls` file, the `updnvrules.sh` script, and an `updnvrules.txt` readme file. To install the new `netview.rls` file and activate the ruleset, run the `updnvrules.sh` script on the IBM Tivoli Enterprise Console Server machine. Please read the `updnvrules.txt` file before running this script. In order to use this script, you must first source your Tivoli environment variables, executing `setup_env.sh`, `setup_env.csh` or
setup_env.cmd. If you are executing on a Windows machine, please run the script under the Tivoli-supplied bash.exe shell.

In the "IBM Tivoli NetView Integration" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README file, the steps required to activate the NetView ruleset are listed. You do not need to perform these steps if you use the updnvrules.sh script because the script does these steps automatically. If you have not already included the NetView ruleset as part of the default rule base, this script will automatically include it for you (but beware, it assumes that the existing netview.baroc file is in the TEC_CLASSES directory of your Default rule base and that it is compatible with the netview.rls file that you are now installing).

**NOTE:** The updnvrules.sh script will restart your Event Server to ensure that the new rules will be loaded.

Please refer to the "Known Defects and Limitations" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README. This section describes the current limitations of the NetView ruleset.

*The new NetView ruleset is supported only on IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 or later. Do not attempt to install this ruleset on an earlier version of IBM Tivoli Enterprise Console.*

**IBM Tivoli Enterprise Console Server Compatibility**

If you are forwarding events from IBM Tivoli NetView to a version of the IBM Tivoli Enterprise Console that is earlier than version 3.7, you must set the `Pre37Server` flag to `YES` in the `/usr/OV/conf/tecint.conf` file by adding the entry `Pre37Server=YES`. You must stop and restart the nvserverd daemon after adding this flag. Use either ovstop/ovstart or Server Setup to stop and restart the daemon.

**New Variable Bindings for NetView Traps**

New variable bindings (varbinds) have been added to the following IBM Tivoli NetView traps:

- "Subnet Unreachable" and "Subnet Reachable Again" events – varbind 7 will contain the network address of the subnet and varbind 8 will contain the subnet mask.
• All interface events – varbind 7 will contain the IP address of the interface and varbind 8 will contain the interface name. The interface name is the short name assigned to an interface (for example, eth0, hme0). This will be used to uniquely identify the interface on a given node.

• All node events – varbind 7 will be empty (unused) and varbind 8 will contain a comma-separated list of the IP addresses of all the interfaces on the node.

• All router events – varbind 7 and 8 are unused.

• All Layer 2 Status events – varbind 7 will be empty (unused), varbind 8 will contain a comma-separated list of IP addresses for all interfaces on the node, varbind 9 will contain the subnet IP address, and varbind 10 will contain the subnet mask.

New NetView Traps

Three traps have been added for Layer 2 events. These are applicable for systems that have the IBM Tivoli Switch Analyzer installed. The Layer 2 traps are:

IBM_NV2_UP_EV 58916984 /* Layer 2 device is UP */
IBM_NV2_DOWN_EV 58916985 /* Layer 2 device is DOWN */
IBM_NV2_MARG_EV 58916986 /* Layer 2 device is MARGINAL */

Eight CNAT-related traps are now installed with IBM Tivoli NetView by default (formerly installed by the NetView CNAT Extensions add-on product from the CNAT product CD):

CNATP_Started 77777770 /* Primary CNAT started */
CNATP_Stopped 77777771 /* Primary CNAT stopped */
CNATP_StartXlate 77777772 /* Primary CNAT started translating */
CNATP_StopXlate 77777773 /* Primary CNAT stopped translating */
CNATR_Started 77777774 /* Redundant CNAT started */
CNATR_Stopped 77777775 /* Redundant CNAT stopped */
CNATRStartXlate 77777776 /* Redundant CNAT started translating */
CNATR_StopXlate 77777777 /* Redundant CNAT stopped translating */
Web MIB Browser Enhancements

- **Viewing MIB Table Information**
  
  To view the information for a particular row of the table (for a particular MIB instance), select a cell in the row. The View button will be enabled. Press the View button to display the data.

- **Graphing MIB Table Information**
  
  To graph the MIB values for a particular column of a table (the values for all or some of the MIB instances), select a cell in the column. If the data for that column is graphable, the column will be highlighted and the Graph button will be enabled. Press the Graph button to graph the data.

- **Filtering the MIB Browser Graph**
  
  When you graph a MIB table column, the graph initially displays all the values for all the MIB instances (all the rows in the table). You can stop the graphing by selecting the Stop button. Once graphing stops, you can request to filter the graph by selecting the Filter button. You are presented with a list of the instances being graphed and can select which elements in the list to graph.

  Like other lists in the Web Console, you can select elements from the list by clicking the left mouse key combined with using the <Shift> and <Ctrl> keys. After marking the desired instances as selected, press the Graph button to begin graphing for just the selected instances.

- **New Timeout pop-up dialog** indicating possible invalid community name or invalid hostname.

- **Improved performance** of timeouts and wait cursors.

- **MIB Browser Refresh Processing with AIX Server**. Due to timing issues and processing by underlying packages used by IBM Tivoli NetView, using the MIB Browser’s main refresh option on AIX may generate some exceptions which show up in the netviewsvlets.log file on the server. These exceptions do not interfere with any processing and can safely be ignored.

  This mainly occurs when the refresh is done in the middle of walking the MIB tree. The same thing might be noticed if you close the MIB Browser while walking the MIB tree.
No sign of these exceptions will show up on the client side unless client-side
debugging is turned on. With SNMP debug on, users may see some
HTTPProxyExceptions.

Examples of exceptions on the server side are:

```
2002-04-02 10:31:25,003 [SocketListener-1/1] ERROR
com.tivoli.netview.http.server.NetViewHttpServlet
  cchato@localhost.127.in-addr.arpa - Caught and rethrew exception in
  service java.io.InterruptedIOException: Read timed out
  java.io.InterruptedIOException: Read timed out

com.tivoli.netview.http.server.NetViewHttpServlet
  cchato@chatoaix.raleigh.tivoli.com - Caught and rethrew exception in
  service java.io.IOException: Premature EOF
  java.io.IOException: Premature EOF.
```

**NOTE:** When you are graphing dynamic tables (such as the ipForwardTable),
if entries are removed while graphing is active,
you will see warning messages in the log. Also, when you refresh
dynamic tables, you may see different rows than before.

**Web Console Security Enhancement**

**Passwords**

In IBM Tivoli NetView Version 7.1.1, user IDs and passwords were stored in
plain text in the NetViewRealm.properties file. In Version 7.1.2, the password
will no longer be stored in plain text.

**Web Console Enhancements**

**Submap Explorer**

The Submap Explorer now displays connections and backbones in the
Unreachable color when the containing network is Unreachable, and provides
new **telnet** functionality. The Submap Explorer will also provide Layer 2
information if the optional IBM Tivoli Switch Analyzer is installed on the
server.
Layer 2 Information. The System Configuration View now contains a Layer 2 Status column. This column will be populated only when connected to a UNIX Web Server that has the IBM Tivoli Switch Analyzer installed.

New Connection Color for Unreachable. When displaying submaps that are parented by Unreachable networks, all connections and backbones are now drawn with the Unreachable color.

Telnet Command. The telnet command is now available from the Object option in the main menu and from an object’s pop-up menu in the IBM Tivoli NetView Web Console application. It is not available when the Web Console is run as an applet. Please note that you can attempt to telnet to any node, but normally only UNIX nodes have a telnet service available.

Object Properties

Object Properties now provides Layer 2 status, new Interface icons, new Interface health information and new service status information. This version of Object Properties also enables you to quickly know whether a node is in an Unreachable area (by looking at the interface health information or by looking at the new icons that appear in the interface table).

Layer 2 Status. The Other tab of the Object Properties screen now shows the Layer 2 status (currently meaningful only for switches). This column will be populated only when connected to a UNIX Web Server that has the IBM Tivoli Switch Analyzer installed.

Interface Icons. The interface table now shows an icon for each interface. The center of each interface icon is drawn in the Unreachable color when the interface’s associated network is Unreachable.

Interface Health. The Interface Health shows the percentage health for a node’s interfaces.

New Service Table. The service table displays the last known services available for the target node and, if any of these services are currently Down, the time of failure is also displayed. These “services” are the services that the nvsniffer program has been configured to discover and monitor.

Diagnostics: QuickTest and QuickTest Critical

Diagnostics QuickTest and QuickTest Critical now provide new Interface icons and Results information to enable you to know whether the node being tested is within an Unreachable area.
• **Interface Icons.** The center of each interface icon is now drawn in the Unreachable color when the interface’s associated network is Unreachable.

• **Results Column.** The Results column now contains text about Unreachable networks when a QuickTest or QuickTest Critical is performed for an interface associated with an Unreachable network.

### Router Fault Isolation (RFI) Enhancements

The Router Fault Isolation (RFI) functionality has been enhanced in three areas:

**Subnets with Routers – suppress all node downs.**

In order to reduce the false signal given by a Node Down event for a device in an Unreachable area, IBM Tivoli NetView does not generate Node Down events for any node in an Unreachable area. The first “node down” that triggers an evaluation resulting in declaring the subnet Unreachable is also suppressed. However, the corresponding “Interface Down” events will continue to be generated until the subnet is declared Unreachable. Afterwards, by default, status polling to Unreachable subnets is suppressed.

**Subnets with some routers known**

In previous versions, the RFI implementation was such that if there was a back door to the subnet via a router IBM Tivoli NetView had not discovered, then it could be declared Unreachable when it was not. This resulted in the subnet often toggling between Unreachable and Marginal. More intelligence has been added in this release to reduce the chances of a Reachable subnet being declared Unreachable.

**Subnets with no routers**

If IBM Tivoli NetView is not managing any routers in a particular subnet, IBM Tivoli NetView can now determine when that subnet is Unreachable. It does this using a probabilistic algorithm, deducing when it is highly likely that the subnet is Unreachable. IBM Tivoli NetView automatically uses this algorithm for subnets where there are no managed routers. However, this algorithm only determines the reachability of the subnet. If it is Unreachable, no Node Down events will be generated.
RFI Configuration

There are three modes for RFI that can be configured:

1. **Disabled** – no attempt will be made to determine reachability or root cause. Routers will generate Node status events, instead of the root cause Router status events.

2. **Router Fault Isolation Mode** – By dynamically evaluating the status of routers, IBM Tivoli NetView will determine the reachability of subnets and the root cause of the partition or problem.

3. **Probabilistic Mode** – By dynamically evaluating the status of members of a subnet, IBM Tivoli NetView will determine whether it is more likely that the subnet itself is Unreachable or whether the device(s) are indeed down. This mode is disabled if the subnet contains less than a configured number of managed devices. This mode is automatically used for subnets with no managed routers if RFI Mode is active. You can fine-tune this algorithm using properties defined in the new configuration file, netmon.conf. See the /usr/OV/conf/netmon.conf file for more details.

To configure the RFI mode, use the Server Setup application. Select **Configure -> Set options for daemons -> Set options for topology, discovery and database daemons -> Set options for netmon daemon** and set the Router Fault Isolation Mode. Also available in Server Setup is the ability to treat ambiguous non-responding router interfaces in unmanaged subnets as Unreachable or Down. Refer to the /usr/OV/doc/RouterFaultIsolation.htm file for information on how and when to use this option.

**New netmon.conf Configuration File**

This is a new configuration file for netmon that can be found in the /usr/OV/conf directory. You can use this file instead of setting environment variables for the netmon daemon. The values in this file will override any environment variables that are set.

This file also contains configuration properties for the Probabilistic Reachability algorithm.
By default, all properties are commented out, except for the new Reachability properties. To use a property, simply uncomment it and set the property as desired, and restart the netmon daemon.

**Status Update Request**

A new script exists that allows you to prompt IBM Tivoli NetView to bring the status of a device up to date. IBM Tivoli NetView will use the appropriate status mode, SNMP or ICMP, to immediately poll all the interfaces on the device, and will then update the map as necessary.

Applications residing on the IBM Tivoli NetView management station can be configured to automatically invoke this script when they learn of a new status for a device. By making use of the script, these applications can force IBM Tivoli NetView to reflect the new status without waiting for the regular status poll cycle. Applications that do not reside on the IBM Tivoli NetView management station may use the contents of this script to see how to send an SNMP trap to IBM Tivoli NetView to force a status poll without waiting for the regular status poll cycle.

*Usage:*

```
/usr/OV/service/nvstatusrequest.sh <NetViewServer_hostname_or_IP_address> <target_hostname_or_IP_address>
```

**nvmaputil Command Line Interface (CLI) Utility**

A new utility, `nvmaputil`, has been added to enable customers to do some limited management from the command line. This utility provides the ability to dynamically modify a NetView map without recycling the netviewd daemon and all its connected Web Console Submap Explorers. In addition, this utility enables visibility into which machines are in-scope for the Scopes defined for Web Server account access.

The nvmaputil utility solves the following type of problem for service providers: a misconfigured node from customer A could appear in customer B’s network. In other words, a misconfigured multi-homed node could report one or more IP addresses that actually belong in another customer’s network. When this situation occurs, it is disruptive to stop the netviewd daemon and bring up the native console to fix the problem, as operators would lose any current Submap Explorer connections as soon as the netviewd daemon is stopped.
The specific management functions this utility addresses are as follows:

– Hide/Unhide an interface and its associated node (or nodes).
– Manage/Unmanage an interface or a node.
– Delete all symbols attached to an object.

See Appendix B: nvmaputil Utility for detailed information about the nvmaputil utility.

Other Enhancements

Cisco Devices SmartSet

A new CiscoDevices SmartSet is created by default during a fresh UNIX installation.

Updates to oid_to_type

The oid_to_type file has been updated with the most current OID information from device vendors.

SNMP Collections

Two new SNMP data collections have been added by default during a fresh UNIX installation: "Bandwidth Utilization for Routers" and "CPU Utilization for Cisco Devices". These collections are turned off by default. To turn them on, use Tools -> Data Collections and Thresholds: SNMP from the native console.

• Bandwidth Utilization (BandwidthUtilHdx)
• CPU Utilization (avgBusy5)

Layer 2 Analysis Option Added to ovtopodump Utility

As a supplement to the optional IBM Tivoli Switch Analyzer product, a new option (-X) has been added to the ovtopodump utility for assessing all Layer 2 devices stored in the topology database. Use this option to help determine why certain nodes are (or are not) considered to be Layer 2 nodes by the IBM Tivoli Switch Analyzer product.

See the IBM Tivoli Switch Analyzer release notes for further information.
Java Runtime Environments

- AIX and Solaris have been upgraded to JRE 1.3.1.
- Linux remains at JRE 1.3.0.

Supported Platforms

- AIX: V4.3.3 (Maintenance Level 09)
- Solaris: V2.7, V2.8 (with all Sun-required patches)
- Linux Intel: RedHat 7.1, SuSe Version 7.1

System Requirements

The system requirements for IBM Tivoli NetView Version 7.1.2 are identical to those described in the installation and system requirements sections of the Tivoli NetView Release Notes, Version 7.1 with three exceptions: one upgrade restriction, additions for the Linux Intel platform, and a new AIX requirement.

Upgrade Restriction

IBM Tivoli NetView Version 5 is no longer supported. Users still running Version 5 must upgrade to Version 6 prior to upgrading to Version 7.

Linux Hardware Prerequisites

- 450 MHz Intel Pentium or faster
- 512 MB of system memory
- 1 GB of swap space
- 500 MB of file system space for the IBM Tivoli NetView program
- 500 MB of file system space for the network database
- Minimum video requirements
– Configure display to use 8 or 24 bit color only proper image display
– Minimum resolution should be 1024X768

Linux Software Prerequisites

IBM Tivoli NetView for Linux Version 7.1.2 runs on RedHat or SuSE Linux for Intel Version 7.1, and requires that the following packages be installed:

• binutils
• inetd
• ucd-snmpd (RedHat rpm is ucd-snmp, SuSE rpm is ucdsnmp) (Version 4.2.2 or higher)
• Xvfb (RedHat rpm is XFree86-Xvfb, SuSE rpm is xextra)
• pdksh (pdksh-5.2.14-8.i386.rpm must be installed from the RPM package provided on the IBM Tivoli NetView for Linux Version 7.1.2 CD-ROM)
• Netscape Version 4.7 or higher

AIX Software Prerequisites

IBM Tivoli NetView Version 7.1.2 now requires that AIX 4.3.3 systems run with Maintenance Level 4330-09 rather than Maintenance Level 4330-08.

Patches Required for this Release

No additional patches are required for IBM Tivoli NetView Version 7.1.2.

Installation Notes

IBM Tivoli NetView Version 7.1.2 is a full image, and can either be installed fresh, or as an upgrade to previous versions of IBM Tivoli NetView (including

1. rpm = Red Hat Package Manager. See man pages for further information about rpm.
IBM Tivoli NetView Version 7.1). The installation instructions on all UNIX platforms for IBM Tivoli NetView Version 7.1.2 are identical to those described in the section "Installing the NetView Program on UNIX" in the Tivoli NetView Version 7.1 Release Notes, with the exception of the Linux Intel platform.

If you are upgrading from a previous version of IBM Tivoli NetView, be sure to remove any old backup directories, such as one that may have been created if you did an upgrade install from Version 6.0 to Version 7.1. Backup directories are located in the /usr directory and are named "OV.back.version".

**Linux Intel Installation**

For installation on a Linux Intel platform, follow the standard non-Framework installation instructions under "Installing the NetView Program in a non-Tivoli Management Framework Environment" found in the "Installing the NetView Program on UNIX" section of the Tivoli NetView Version 7.1 Release Notes.

Prior to the installation of IBM Tivoli NetView Version 7.1.2, the /etc/hosts file must be configured to insure proper topology discovery. The hosts file must include both the fully qualified hostname and the shortname for the host on the line giving the host's IP address, for example:

```
123.45.67.89  myhost.local.domain.com  myhost
```

Once IBM Tivoli NetView Version 7.1.2 has been installed on the Linux Intel platform, edit the /etc/snmp/snmpd.conf file to add the following pass-through statement:

```
pass  .1.3.6.1.4.1.2.6.4.6.1  /bin/sh /usr/OV/bin/mgragentd
```

This configures the SNMP daemon to forward a request for a MIB variable to the IBM Tivoli NetView server.

After the /etc/snmp/snmpd.conf file is edited, stop and restart SNMP by typing the following commands:

```
/etc/init.d/snmpd stop
/etc/init.d/snmpd start
```
Deprecated

The **Submap Explorer** option under the **Tools** menu has been removed from IBM Tivoli NetView UNIX Version 7.x. You can use **Tools -> Launch Web Console** instead of the old Submap Explorer.

Defects Fixed in this Release

The following is a list of the customer-reported problems fixed in IBM Tivoli NetView Version 7.1.2, followed by a list of customer-reported problems fixed in IBM Tivoli NetView Version 7.1.1:

<table>
<thead>
<tr>
<th>APAR #</th>
<th>Abstract of Version 7.1.2 Fixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY25741</td>
<td>OVSNMPCONFCLOSE() fails to release all file descriptors</td>
</tr>
<tr>
<td>IY27439</td>
<td>Check route node in ruleset shows incorrect setting</td>
</tr>
<tr>
<td>IY28079</td>
<td>IPMap trap input character described wrong in documentation</td>
</tr>
<tr>
<td>IY28144</td>
<td>NVSecD aborts with signal 4 and cores</td>
</tr>
<tr>
<td>IY28188</td>
<td>Memory management problems in NVCorrD leads to core</td>
</tr>
<tr>
<td>IY28360</td>
<td>Readcore hangs instead of returning useful error message</td>
</tr>
<tr>
<td>IY28494</td>
<td>Netviewd daemon pop-up boxes cannot be acknowledged</td>
</tr>
<tr>
<td>IY28526</td>
<td>SNMP configuration not updated by communityname.conf entry</td>
</tr>
<tr>
<td>IY28665</td>
<td>NVDBFormat SELECTRULE not searching entire list</td>
</tr>
<tr>
<td>IY28719</td>
<td>NVCorrD cores after ruleset change</td>
</tr>
<tr>
<td>IY28730</td>
<td>Segment status incorrect when interface is Admin Down</td>
</tr>
<tr>
<td>IY28800</td>
<td>Sysmon changes to correct CERT violations</td>
</tr>
<tr>
<td>IY28834</td>
<td>NVCorrD cores when user script overflows buffer</td>
</tr>
<tr>
<td>IY28841</td>
<td>Serversetup has bad default value for &quot;SERVERPORT&quot; field</td>
</tr>
<tr>
<td>IY28934</td>
<td>Rectrap cores when undefined trap received</td>
</tr>
</tbody>
</table>
APAR # | Abstract of Version 7.1.2 Fixes
---|---
IY29129 | liblocal ICMP messages may be dropped due to contents
IY29166 | Paging queue fills/cores without giving any messages
IY29171 | Multiple netmon memory leaks
IY29203 | Users Guide talks about "SUBMAP EXPLORER"
IY29356 | No documentation for moving between location containers
IY29374 | Performance issue after fix to man/unman node propagation
IY29392 | Discovery fails if address is already as AD in object DB
PJ28175 | NetmonNT core in function checkconninfo
PJ28510 | Correction of WebServer security leak

APAR # | Abstract of Version 7.1.1 Fixes
---|---
IY08054 | xnmsnmpconf -update and -delete fail when using wildcards
IY18214 | Need mechanism to clear invalid map timestamp
IY21738 | Query SmartSet node doesn't work for interface selection names
IY21803 | NVColdD not deleting interface when its deleted from IPMAP
IY22700 | Trapd cores using NVAddTrapDConf with large event name
IY23199 | NVCold wrongly handles node with "Admin Down" interfaces
IY23387 | SNMPCollect "Test" function window does not scroll
IY23828 | MAC Addr of 0X000000000000 should be ignored for HSRP
IY23872 | SNMP Status Polling problem during HSRP processing
IY24273 | ISACKNOWLEDGED Field not reset to false in ovwdb
IY24405 | Cut and Paste of location objects with contents not working
IY24614 | NVDBFormat footer contains incorrect number of objects found
IY24675 | Documentation incorrect for MLM Activation panel
IY24841 | Can't get object info when brackets in SELECTIONNAMES
<table>
<thead>
<tr>
<th>APAR #</th>
<th>Abstract of Version 7.1.1 Fixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY24846</td>
<td>Older version of Release Notes shipped on NetView 7.1 CD</td>
</tr>
<tr>
<td>IY24858</td>
<td>Netview Maps hung waiting for data from socket</td>
</tr>
<tr>
<td>IY25294</td>
<td>SmartSet object count does not equal that of NVUtil -l</td>
</tr>
<tr>
<td>IY25342</td>
<td>Unmanaged network object does not have unmanaged IP status</td>
</tr>
<tr>
<td>IY25469</td>
<td>Map freezes when GLOBAL ACKNOWLEDGED enabled</td>
</tr>
<tr>
<td>IY25660</td>
<td>Memory leak found in OVWDB</td>
</tr>
<tr>
<td>IY25791</td>
<td>LANG variable not documented properly in 7.1 Release Notes</td>
</tr>
<tr>
<td>IY25810</td>
<td>NetView 7.1 IPMAP cores when using location.conf</td>
</tr>
<tr>
<td>IY25819</td>
<td>SMConvert line wraps causing incorrect results downstream</td>
</tr>
<tr>
<td>IY25937</td>
<td>UNIX Polling file location incorrect in 7.1 Release Notes</td>
</tr>
<tr>
<td>IY25937</td>
<td>RFI incorrectly handling &quot;Admin Down&quot; interfaces</td>
</tr>
<tr>
<td>IY25971</td>
<td>NVCorrD cores with signal 11 due to memory leaks</td>
</tr>
<tr>
<td>IY25986</td>
<td>Map turns grey / freezes until dbxprof performed on OVWDB</td>
</tr>
<tr>
<td>IY26119</td>
<td>SNMP address being changed by NETMON</td>
</tr>
<tr>
<td>IY26301</td>
<td>COLLMAP fills nv6000.log with messages on socket problem</td>
</tr>
<tr>
<td>IY26404</td>
<td>Unneeded &quot;address changed&quot; traps during status polling</td>
</tr>
<tr>
<td>IY26405</td>
<td>Synchronization times between XXMAP and GTMD too slow</td>
</tr>
<tr>
<td>IY26423</td>
<td>Resolve database inconsistencies fails</td>
</tr>
<tr>
<td>IY26486</td>
<td>NVStat and OVStatus showing incorrect pids for Web daemons</td>
</tr>
<tr>
<td>IY26581</td>
<td>&quot;Admin Down&quot; Interfaces forcing frequent router checks</td>
</tr>
<tr>
<td>IY26725</td>
<td>Trapfiler at MLM doesn't work with default trap destination</td>
</tr>
<tr>
<td>IY26983</td>
<td>Number of SRFS and ARFS limited per domain</td>
</tr>
<tr>
<td>IY27008</td>
<td>NVCOLTOSQL collecttime variable uses 2 digit year</td>
</tr>
<tr>
<td>IY27110</td>
<td>Selecting networks in serversetup for netmon not correct</td>
</tr>
<tr>
<td>IY27193</td>
<td>NVSniffer traps are inconsistent between NT and AIX</td>
</tr>
</tbody>
</table>
### Known Limitations

1. Use of IBM Tivoli NetView Web Console Security on UNIX systems requires root permissions. If you attempt to invoke Web Console Security as a non-root user on a UNIX system, you will be denied access to Web Console Security and error messages will be displayed.

2. The Version 7.1 mib2trap option of mibloader.sh does not recognize the following special comments that begin with "--#".

   --#SUMMARY "Root cause failure: %s %s (%s)"
   --#ARGUMENTS ( 2, 1, 0 )
   --#SEVERITY CRITICAL
   --#STATE NONOPERATIONAL
   --#SLOTMAP origin $V1
   --#SLOTMAP hostname $V2
   --#SLOTMAP protocol $V3

3. Removing any one IBM Tivoli NetView installation within a Tivoli Managed Region (TMR) also removes the Tivoli Framework registry entries within the Tivoli Framework database for all IBM Tivoli NetView installations.

### APAR # Abstract of Version 7.1.1 Fixes

<table>
<thead>
<tr>
<th>APAR #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY27343</td>
<td>OVActionD logging too verbose since trap security fix</td>
</tr>
<tr>
<td>IY27459</td>
<td>Modified netmon coring due to invalid object pointer</td>
</tr>
<tr>
<td>IY27554</td>
<td>ISACKNOWLEDGED not set to true for non-IP object</td>
</tr>
<tr>
<td>IY27692</td>
<td>Missing java library error when running java app scripts</td>
</tr>
<tr>
<td>IY27784</td>
<td>CiscoWorks 2000 install doc missing from netview 7.1 CD</td>
</tr>
<tr>
<td>IY28152</td>
<td>Missing argument descriptions in documentation for NVSniffer</td>
</tr>
<tr>
<td>IY28117</td>
<td>Large database causing long Web Client synchronization</td>
</tr>
<tr>
<td>IY28562</td>
<td>NetView fails CERT CA-2002-03 Test Cases</td>
</tr>
<tr>
<td>PJ28326</td>
<td>Syntax errors in netnmrc for NetView V7.1</td>
</tr>
</tbody>
</table>
installations, and it appears as if there is no IBM Tivoli NetView product installed on any node. A workaround for this problem is to simply reinstall the IBM Tivoli NetView installations that are still installed. The Tivoli Framework will state that all components are already installed on that system, and when the “Continue” button is pressed, the registry entry will be rebuilt.

4. On the Solaris operating system, some IBM Tivoli NetView man pages are not visible to the man command. Until the correct system patch can be determined, set the environment variable "MANPATH" to "$MANPATH:/usr/share/man:/usr/OV/man".

5. The *Tivoli NetView Version 7.1 Release Notes* state that the install documentation for CiscoWorks 2000 is included in the /Adapters/Cisco directory of the IBM Tivoli NetView Version 7.1 CD-ROM. This file was inadvertently left off of the IBM Tivoli NetView Version 7.1 CD-ROM; it can be found in the same directory on the IBM Tivoli NetView for UNIX Version 7.1.2 CD-ROM.

6. On Red Hat Linux, when running IBM Tivoli NetView for UNIX Version 7.1.2, you cannot double-click on a resource to open a view. This problem surfaces when running under the Sawfish Window Manager in the Gnome desktop. One alternative is to choose a different window manager such as "TWM", or another desktop such as "KDE".

A second alternative is to change the Sawfish Window Manager defaults:

a. Start the Gnome control center.

b. Choose *Sawfish Window Manager -> Shortcuts*.

c. From the drop-down list labeled *Context*, choose *Window*.

d. From the list, delete the three lines in which the command field is *Raise Transients and pass through click*.

e. Click on *OK*.

f. Choose *Sawfish Window Manager -> Focus Behavior*.

g. From the resulting window, choose the *Focus* tab.

h. Check *Raise windows when they are focused*.

i. Click on *OK*. 
7. The Global Acknowledge function provided by IPMAP is designed to work only with those objects in the map created and managed by IPMAP. Global Acknowledge for non-IP map objects created by the user or other Ovw applications is not supported.

8. If you are upgrading to IBM Tivoli NetView Version 7.1.2 and have the TBSM Adapter installed, you will need to contact your IBM/Tivoli representative for an update to the TBSM Adapter.

9. We no longer ship the nvserverd.baroc and nvserverd.rls files with IBM Tivoli NetView Version 7.1.2. They are no longer necessary with the new enhanced integration between IBM Tivoli NetView and IBM Tivoli Enterprise Console.

   However, these files are not removed during an upgrade installation for existing customers who still use the old "OV" style event class structure.

   A new NetView ruleset file is shipped with IBM Tivoli Enterprise Console 3.7.1 Fixpack 02. Refer to the Fixpack 02 README file for information on activating this new ruleset.

10. IBM Tivoli NetView for UNIX servers must run on a system with a fixed TCP/IP address, not one that uses DHCP.

11. We have seen problems resulting from the Linux routing cache containing stale incorrect entries. A symptom of a stale entry is when you can not Demandpoll a node that is Up, but you can access it through the MIB Browser.

    Remedy: See the Linux documentation for instructions on deleting the default route entry and re-adding it in order to flush the stale entry. If the problem is that the route table and route cache do not show the same next hop entries for your destination of interest, then you may be experiencing ICMP redirect problems. Consult your operating system documentation for instructions on how to disable redirects if you do not want redirects to take place on your IBM Tivoli NetView workstation.

12. If the total number of objects in your IBM Tivoli NetView for AIX database exceeds 50,000, see the ovtopofix_readme.txt file in the TOOLS directory located at the top level of the product CD prior to upgrading to Version 7.1.2.
1. In the *Tivoli NetView Version 7.1 Release Notes*, the title header "Polling Configuration File Changes" on page 33 should have the string "(Windows only)" appended since these changes are not applicable to IBM Tivoli NetView for UNIX Version 7.1.

2. The *Tivoli NetView Version 7.1 Release Notes* found in the pdf file in the top level directory of the IBM Tivoli NetView for UNIX Version 7.1 CD-ROM were an earlier version of the release notes. The html file found in the top level directory of the IBM Tivoli NetView Version 7.1 CD-ROM, the pdf and html versions found in the directory /usr/OV/books/C of the IBM Tivoli NetView Version 7.1 installation, and the hardcopy version of release notes shipped as a part of IBM Tivoli NetView Version 7.1 are more up-to-date and correct versions of the file.

3. In the *Tivoli NetView Version 7.1 Release Notes*, the incorrect locale is given for AIX on page 97. The statement:

   On an AIX system using Bourne or Korn shell, enter the following:

   ```
   export LANG=en_US
   export LC_MESSAGES=en_US
   ```

   should be changed to:

   On an AIX system using Bourne or Korn shell, enter the following:

   ```
   export LANG=En_US
   export LC_MESSAGES=En_US
   ```

4. The *Tivoli NetView for UNIX Administrator’s Reference* manual for Version 7.1 doesn’t mention all of the flags for nvsniffer that are described in the IBM Tivoli NetView nvsniffer man page. The reference manual should also include the following arguments:

   `-d` Optionally, log to stderr the node/service combination about to be tested. Useful for diagnosing nodes that are slow to respond. Works best when used with one worker thread (`"-t 1"`) to avoid scrambled output.
-l logFile  Optionally, specify a log file to store the progress of nvsniffer. If the named log file already exists, the existing file will be appended.

-m  Optionally, force the nvsniffer command to execute even if another instance of nvsniffer is already running. Use this option sparingly since each instance of nvsniffer can consume significant system resources.

-o  Optionally, test nodes that do not have an IP status of either Normal or Marginal. Nodes having an IP status of Critical are otherwise not tested.

-p physmem  Optionally specify the maximum amount of virtual memory (in megabytes) the Java Virtual Machine (JVM) running the nvsniffer application should occupy. The value specified for this option is not validated by nvsniffer; it is passed directly to the JVM that will execute the nvsniffer application. Tivoli recommends avoiding values higher than 64, especially if the -m option is used.

-r minutes  Optionally, re-run the current nvsniffer command in the specified number of minutes using the current set of switches. The valid range is 5 ... 44640 minutes (up to 31 days maximum).

-s  Optionally, run nvsniffer in Status mode to test all known services for their current status. The node selection criteria for each entry is the {Service SmartSet} field. Running nvsniffer in Status mode is typically faster than using the default (Discover) mode, since only known services are tested.

-T timeout  Optionally, override the time to allow a test to complete (in seconds). The default is 10 seconds. For raw TCP port tests, some platforms do not allow such tests to be timed out; therefore if the time taken to perform raw port tests to a given node exceeds the timeout value, all remaining raw port tests to that node are skipped and a warning message is displayed. The maximum value allowed is 120.

-v  Optionally, make nvsniffer display more verbose output regarding its progress.
5. The *NetView for UNIX Configuration Guide Version 7*, "Customizing Startup" section on Page 13, shows the following statement:

   To customize the startup process, modify the `/usr/OV/bin/netnmrc.appsetup` shell script, `/usr/OV/bin/netnmrc.pre` shell script, or `/usr/OV/bin/netnmrc.aux` shell script, rather than the `netview` and `netnmrc` shell scripts.

   The reference to `/usr/OV/bin/netnmrc.appsetup` should be changed to `/usr/OV/bin/applsetup`.

6. The *NetView for UNIX Configuration Guide Version 7*, "Using Alternate Community Names" section, begins at the bottom of page 55. The top of page 56 should be changed as follows.

   The following section is incorrect:

   Normally, `netmon` will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use `public`, the default. If this fails, `netmon` will use the list in the `communityNames.conf` file, but only under the following circumstances...

   It should be changed to:

   Normally, `netmon` will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use the global default. If this fails, `netmon` will use the list in the `communityNames.conf` file. The `public` community name will be used only if it is configured for a specific node, configured as the global default, or is listed in the `communityNames.conf` file. `Netmon` will use the list in the `communityNames.conf` file only under the following circumstances...

7. The *NetView Release Notes for Version 7.1* (*readme* on page 67 and 68) and 7.1.1 (*readmeupd* on Page 6, number 5) should have included the following further information about the potential security problem resolution:

   **Security Problem Description**

   Several modifications have been added to this description originally listed in the *NetView Release Notes for Version 7.1*, including an example of a sample script to remove escape characters, and will be listed in its entirety here.
A fix has been made to ovactiond, nvcorrd and actionsvr to close up a potential security hole where any non-authorized user, with some knowledge of IBM Tivoli NetView trap customization, could gain root access to the IBM Tivoli NetView system by sending a trap to the IBM Tivoli NetView system from anywhere in the network.

This did not happen in the product as it is shipped, but could occur after trap customization was done by the IBM Tivoli NetView administrator or by someone with root authority on the IBM Tivoli NetView system.

The security hole can be opened when a trap is customized to include a variable in the "Command for Automatic Action" field, in the "Action" field of an Action Node in a ruleset, or the "Command" field of an Inline Action Node in a ruleset. A trap could then be sent from any system using command substitution, rather than the intended variable, to execute unauthorized operating system commands on the IBM Tivoli NetView system.

The UNIX daemons impacted by this fix are ovactiond, nvcorrd and actionsvr.

A list of the modified characters follows:

$ ` ; & | @ # % ^ < > \ / = { } - " !

When these characters are encountered, a message is entered into the appropriate daemon log file.

**Problem Resolution**

The ovactiond, nvcorrd and actionsvr daemons now filter out all non alpha-numeric characters except for the minus sign ( - ) and the decimal point ( . ). All characters not falling into this set will be replaced with an underscore ( _ ). If a minus sign or decimal point is encountered it will be escaped (for example, preceded by a backslash ( \ )) as a precaution. If any non alpha-numeric character is encountered, and filtering is not disabled, a message will be entered into the appropriate log file (/usr/OV/log/nvcorrd.alog, /usr/OV/log/ ovactiond.log, and /usr/OV/log/nvaction.alog).

The user can customize this behavior by using an environment variable called AdditionalLegalTrapCharacters. If the user sets this variable to the string "disable", then no filtering will be done. If the user sets this environment variable to a string containing non alpha-
numeric characters, then the filtering will allow those characters to also pass through the filter, but they will be escaped. The best method for setting an environment variable for an ovspmd controlled daemon is to put the definition of the environment variable into the /usr/OV/bin/netnmrc.pre file, then stop and restart all the daemons (using netnmrc to restart).

Notes

1. The contents of the environment variable AdditionalLegalTrapCharacters must be quoted, and some of the characters will have to be escaped to avoid being operated on by the shell or the system. The following assignment demonstrates a valid string for the AdditionalLegalTrapCharacters variable:

   AdditionalLegalTrapCharacters=
   " ! @ # /$ % ^ & * ( ) _ + | \ ~ ` \ = - ] [ ' ; /. , ? > < " : } { "

2. The following demonstrates a simple user script which can be used to remove the escape characters put into a string by this fix:

   #!/bin/ksh
   #
   # The purpose of this script is to simulate a user script which
   # sends a page after some processing to test nvcorrd and actionsvr
   #
   # We used to send the following:
   # /usr/OV/bin/nvpage 1234567@skytel hi joe `date` $NVS
   #\n   #\n   # Now we will use sed to remove the escape characters
   set -x
   # fix up $NVATTR_2 to remove backslash "\"
   host=`echo $NVATTR_2 | sed "s:\\\:g"
   echo $host
   /usr/OV/bin/nvpage 1234567@skytel hi joe `date` $NVS $host
   exit
   #
8. The *Version 7 User’s Guide* discusses use of the Submap Explorer on page 51. This has been deprecated. Please refer to the *Deprecated* section for further information.

9. The "System Configuration Requirements" section was inadvertently omitted from the *NetView for UNIX Configuration Guide, Version 7*. This information should be part of the Installation section of the release notes.

**System Configuration Requirements**

System configuration requirements are provided in the following section for AIX and Solaris.

**AIX Configuration**

The maximum number of processes allowed per user value should be set to at least 120. This is only a recommendation, and will depend on the expected usage of the system. This value is found in SMIT under **System Environments -> Change/Show Characteristics of Operating System**.

**Solaris Configuration**

Use these settings to configure Solaris.

- Before installing the IBM Tivoli NetView program, add the following three lines to the /etc/system file:
  
  set msgsys:msginfo_msgmax = 0x8000
  set msgsys:msginfo_msgmnb = 0x8000
  set msgsys:msginfo_msgseg = 0x1000

  Note that the machine will need to be restarted for the changes to take effect.

- Define the following environment variable that is in the process used to install and execute the IBM Tivoli NetView program:

  XKEYSYMDB=/usr/openwin/lib/XKeysymDB

10. The following section from the Version 6 release notes was inadvertently omitted from the Version 7.1 release notes.

    Configuring your Database for Routers with More than 20 Interfaces:
If your network consists of any routers with more than 20 interfaces, then you will need to reconfigure the IBM Tivoli NetView OVw object database. If you don't perform this action, these routers may not be discovered correctly during IBM Tivoli NetView discovery.

To reconfigure the IBM Tivoli NetView OVw object database, use the /usr/OV/service/nvTurboDatabase tool at any point after creating the databases. When you use this tool, be aware of these restrictions:

- If you regenerate the OVw databases, you must run the tool again. It can be run at any time, regardless of whether or not the databases are empty.
- You must not run utilities that compact the databases, such as the commands:
  
  `ovtopofix -C`  
  `ovwdbdmap -c`

To reconfigure the IBM Tivoli NetView OVw object database, shut down all IBM Tivoli NetView GUIs and then issue the following command from the command line:

```
/usr/OV/service/nvTurboDatabase space
```

For more information on this utility, see Appendix G "Database Enhancements in Tivoli NetView" in the *Tivoli NetView for UNIX Configuration* book. Note that this section now applies to AIX and Solaris.

11. The man pages for the `event` command and for `trapd.conf` contain a typographical error. This error is that the source character used to represent the ipmap process (identified as "Ipmap sa") is given as "+") instead of "I". The plus "+" character is used in the man pages as the bullet character of a bulleted list, so there was a formatting problem when the man pages were extracted.

If one attempts to use the "+" in an event command, as in

```
  event -h host1 -e MN_EV -s +
```

it will result in the error message:

```
  invalid source +
```

The correct command would be

```
  event -h host1 -e MN_EV -s I
```
There are no IBM Tivoli NetView traps defined in trapd.conf with a source character of "+", though the user is at liberty to add his own traps or modify existing ones and use this value as the source. The IBM Tivoli NetView traps from ipmap defined in trapd.conf all have the source character of "I".

12. The documentation (both the manuals and the location.conf file) should contain the following information that was inadvertently omitted from the Version 7.1 release notes:

Care must be taken when a user moves a symbol whose location is defined in the location.conf file. If such a symbol is cut and pasted to a new location, then duplicate symbols will appear when IPMAP is restarted; one in the original location described in the location.conf file, and one in the new location defined by the cut and paste operation. If duplicate symbols are not desired, then the user must either remove the symbol from the location.conf file, or modify the location.conf file to reflect the symbol's new location.

13. In the “Software Requirements” section of "Installing the NetView Program on UNIX" in the *Tivoli NetView Release Notes Version 7.1*, one of the Additional Information bullet items states:

- If you want to use RIM with NetView Version 7.1 on Solaris you must use Tivoli Management Framework 3.6.3 and not the 3.7 version of Tivoli Management Framework.

This restriction was removed in Version 7.1.1 but was inadvertently omitted from the Version 7.1.1 release notes.

14. In the *Tivoli NetView Release Notes Version 7.1*, "Installing the Tivoli Integration Pack for Tivoli NetView (TIPN)" was discussed on page 113. The bulleted items in this section are correct, but references to the TIPN CD-ROM are obsolete. As described in the bullet item, the IBM Tivoli Enterprise Console functionality is now incorporated into the base NetView package.

15. The documentation (both the manuals and the location.conf file) should warn that a user should not cut from a manually-created location container and paste into a location container that was created by the location.conf file and vice-versa. Also, cutting and pasting between location containers created by the location.conf file is not recommended.
Product Notes

1. This product contains commands, scripts and tools that are not documented in manuals or on-line help which are intended for use by Tivoli service personnel, and are not supported for general customer use.

2. If installing through the IBM Tivoli Framework, install the IBM Tivoli NetView Framework patch on all systems where IBM Tivoli NetView is being installed. Both the Tivoli Framework Installation Patch and the IBM Tivoli NetView Framework Patch must be installed on the TMR server and on the managed nodes where IBM Tivoli NetView will reside.

3. If the IBM Tivoli NetView server encounters out-of-memory errors, the following dialog will appear on every Web Console that is attached to that server:
   - The Web Server is unstable.
   - Results are unpredictable.
   - Contact the NetView administrator.

   In addition to these error messages, you will also notice stack traces appearing in the window that launched the Web Console. These stack traces normally mention that a 503 error code was received (for example, "received bad HTTP response code '503'").

   If this occurs, the IBM Tivoli NetView administrator should look at /usr/OV/www/logs/netviewservlets.log for any occurrences of the string "OutOfMemoryError":

   If such a string is found, the administrator should boost the memory setting that the webserver uses. This can be done as follows:

   a. Stop the Web Server using the command **ovstop webserver**.

   b. Modify the file /usr/OV/www/bin/jetty.sh by changing the ","-Xmx64m" string found on the JAVA_OPTIONS line to be something larger, like "-Xmx96m". The "Xmx" setting is used to specify the maximum size of Java's memory allocation pool. The IBM Tivoli NetView program ships with the default set to "-Xmx64m" (64MB).

   c. Start the Web Server using the command **ovstart webserver**.
4. The Web Console should be upgraded to Version 7.1.2 on all systems. However, doing so will result in the loss of the list of hosts to which the Web Console has been previously connected that appears in the login dialog. This list can be retained by saving away the file
lib/properties/DefaultHostAndPort.properties in the Web Console install directory before upgrading, and then copying it back afterwards, overwriting the newly-installed version.

5. The following functionality has not been included in the Linux Intel platform release of IBM Tivoli NetView for UNIX Version 7.1.2.
   a. Agent Policy Manager (APM), C5eui, and MLM (Linux will have limited support for remote MLM configuration).
   b. Tralerld and Spappld (the preferred method is to use MSM/IP and trap forwarding).
   c. MLM.
   d. Native Client Support (the Java Console is replacing the native client mechanism).
   e. XMP API support (for CMIP and CMOT applications)
   f. RIM Database Support (there will be no support for TME RIM).
   g. TME Installation (Linux installation will always be Tivoli Framework independent).
   h. Tivoli Integration Pack for IBM Tivoli NetView (TIPN supports integration with TME Framework components).
   i. Backup Manager.

6. In general, devices that support the dot1dBridge MIB are supported by the new Diagnostics Switch Management views.

7. The new MPLS Management views are supported on devices that support the MPLS LSR MIB.

8. The nvTurboDatabase utility is designed to compress the object database. After many adds and deletes of objects, the database can get very fragmented. Using this utility can reduce the disk space used. This utility became available in NetView V6.0.3, but was inadvertently omitted from the release notes. The nvTurboDatabase utility can be found in the /
usr/OV/service directory and more information about it can be found under "The dbmcompress Utility" section of the NetView for UNIX Configuration Guide Version 7.

9. If you encounter any problems with the new telnet option, verify that the TELNET_COMMAND path is correct in the /usr/OV/bin/nvwc.sh file.

10. Starting with IBM Tivoli NetView Version 7.1.1, the IBM Tivoli NetView CNAT components formerly installed as an add-on to IBM Tivoli NetView from the Comprehensive Network Address Translator product distribution (product number 5698-NAT) are now part of the standard IBM Tivoli NetView product.

The nvCNAT components add the **CNAT Operations** menu options under the Tools menu. These menu options enable IBM Tivoli NetView to discover all CNAT devices in your network and to automatically download all information necessary to identify all nodes in the network that IBM Tivoli NetView has discovered which have IP addresses that have been translated by the CNAT devices. Node symbols (and the affected interface symbols) that have had their IP addresses translated by a CNAT system will have a "**" prefix and suffix added to the label name. For example, if node "systema.company.com" has an interface with an IP address that has been translated by a CNAT, the node’s symbol label will be modified to "**systema.company.com**", and the corresponding interface symbol label will also contain the added "**" prefix and suffix.

If you already have nvCNAT installed, it will automatically be migrated if you are upgrading to IBM Tivoli NetView Version 7.1.2, and the nvCNAT uninstaller is automatically disabled to prevent accidental loss of nvCNAT capability.

For additional nvCNAT product information, please refer to the **CNAT Guide and Reference** located on the CNAT product CD.

11. To send IBM Tivoli NetView Web Console log messages to a file, edit one of the following files:

If running from /usr/OV/bin/nvwc.sh, edit this file:

    /usr/OV/www/webapps/netview/log4j.properties

If running from %NVWC_HOME%/bin/nvwc.sh, edit this file:

    %NVWC_HOME%/lib/log4j.properties
If running from the IBM Tivoli NetView Web Console applet, edit this file:

```
/usr/OV/www/webapps/netview/log4j.properties [on the webserver]
```

Edit log4j.properties by adding the following lines (after the existing ConsoleAppender):

```
log4j.appender.R=org.apache.log4j.RollingFileAppender
  # Specify the file where you want the output to go.
log4j.appender.R.File=/usr/OV/www/logs/webconsole.log
log4j.appender.R.MaxFileSize=100KB
  # Keep one backup file
log4j.appender.R.MaxBackupIndex=1
log4j.appender.R.layout=org.apache.log4j.PatternLayout
log4j.appender.R.layout.ConversionPattern=%d{ISO8601} [%t] %-5p %c %x - %m%n
```

Modify the line:

```
log4j.rootCategory=INFO, A1
```

to be:

```
log4j.rootCategory=INFO, A1, R
```

**NOTE:** This adds the new file appender to the category.

To turn on debugging for a particular IBM Tivoli NetView category or component, modify the line for that particular category (for example, snmp) as shown below.

Change:

```
log4j.category.com.tivoli.netview.snmp=INFO
```

to:

```
log4j.category.com.tivoli.netview.snmp=DEBUG
```

12. If you install IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 on a machine that also has the IBM Tivoli NetView Version 7.1.2 server installed, you must separately install the IBM Tivoli NetView Web
Console if you wish to perform integrated product launching. This integrated product launching enables you to select an event in the IBM Tivoli Enterprise Console and perform a context launch of Submap Explorer, Object Properties or Diagnostics. The launch request results in a new Submap Explorer, Object Properties or Diagnostics view within an IBM Tivoli NetView Web Console and the context of the launch will be the hostname associated with the originally-selected IBM Tivoli Enterprise Console event. See "Installing the NetView Web Console" in the Tivoli NetView Release Notes Version 7.1 for information on installing the IBM Tivoli NetView Web Console.

Installing and Using the IBM Tivoli NetView Language Kits

This section provides important information about installing and using the IBM Tivoli NetView for UNIX Version 7.1.2 Language Kit. Please read this section thoroughly before installing or using the Language Kit.

IBM Tivoli NetView Version 7.1.2 has new language kits. If you are upgrading from IBM Tivoli NetView Version 7.1.1 to Version 7.1.2, you must also install the Version 7.1.2 Language Kit.

**Supported Languages:**

AIX:  
- English
- Korean EUC
- Japanese EUC
- Japanese Shift JIS
- Simplified Chinese EUC

Solaris:  
- English
- Korean EUC
- Japanese EUC
- Simplified Chinese EUC
Installation Requirements

The following hardware and software prerequisites must be met before installing the IBM Tivoli NetView Language Kits:

- AIX: Version 4.3.3 with Maintenance Level 09
- Solaris: Version 2.7 or 2.8 with all Sun-recommended patches
- Tivoli NetView for UNIX Version 7.1.2 base English kit
- 110 MB disk space on the /usr/OV partition per language (not including English). Please note that some portion of this space is required by the installation process and will be released afterwards.

Installing the Tivoli NetView Language Kits

The following checklist provides the list of tasks you must complete in order to successfully install the Tivoli NetView Language Kits.

1. Set the LANG environment variable to the English locale.
   
   Refer to "Setting the LANG and LC_MESSAGES Variables" in the Tivoli NetView Release Notes Version 7.1 for information about how to set this environment variable. This variable must be set to the English locale when installing the IBM Tivoli NetView base English kit (client or server).

2. Install the IBM Tivoli NetView for UNIX Version 7.1.2 base English kit.
   
   The IBM Tivoli NetView base kit must be installed before the Language Kits. The Language Kits are installed on top of the base kit. This kit is located on the IBM Tivoli NetView for UNIX Version 7.1.2 CD-ROM that is included with the NetView distribution. Refer to the Tivoli NetView Release Notes Version 7.1 for instructions on how to install the base kit.

3. If you are installing the Language Kit on an IBM Tivoli NetView client, you must first disconnect the client from the server. The Language Kit installation will fail if the client is currently connected to a server. If you have connected the IBM Tivoli NetView client to a server, you must disconnect it before installing the Language Kit on the client. Use the Client Setup application (clientsetup) to remove the server from the client before installing the Language Kit (Configure -> RemoveServer).
4. Stop all IBM Tivoli NetView native Consoles. If you have started the native Console on the server, or on any clients, you must shut them down before installing the Language Kits.

5. Install the NetView Language Kits.

   **In a non-Framework environment:**

   To install the Language Kit in an environment that does not include the Tivoli Management Framework, on a command line, `cd` to where the CD-ROM is mounted and type:

   ```
   ./installns -k KIT -l LOCALE
   ```

   where `KIT` is the type of installation required: `CLIENT`, `SERVER`, or `BOOKS` and `LOCALE` is the locale of the server: `ko` (Korean), `zh` (Chinese), `ja_euc` (Japanese EUC), `ja_sjis` (Japanese Shift JIS).

   **In a Framework environment:**

   To install the Language Kit in an environment that includes the Tivoli Management Framework, refer to "Installing the NetView Program in a Tivoli Management Framework Environment" in the *Tivoli NetView Release Notes Version 7.1.*

   Using the Tivoli Management Framework, choose the appropriate kit from the **Select Product to Install** list:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Type of Installation</th>
<th>Kit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX, Solaris</td>
<td>Simplified Chinese Server</td>
<td>IBM Tivoli NetView Simplified Chinese Server Version 7.1.2</td>
</tr>
<tr>
<td>AIX, Solaris</td>
<td>Simplified Chinese Client</td>
<td>IBM Tivoli NetView Simplified Chinese Client Version 7.1.2</td>
</tr>
<tr>
<td>AIX, Solaris</td>
<td>Korean Server</td>
<td>IBM Tivoli NetView Korean Server Version 7.1.2</td>
</tr>
<tr>
<td>AIX, Solaris</td>
<td>Korean Client</td>
<td>IBM Tivoli NetView Korean Client Version 7.1.2</td>
</tr>
<tr>
<td>AIX, Solaris</td>
<td>Japanese EUC Server</td>
<td>IBM Tivoli NetView Japanese EUC Server Version 7.1.2</td>
</tr>
</tbody>
</table>
The on-line books are installed as a separate kit. The kit names are given in the table above. Before installing any of the language books kits, you must first install the **IBM Tivoli NetView Books 7.1.2** kit from the IBM Tivoli NetView for UNIX Version 7.1.2 CD-ROM and the base language kit for the operating system.

Note that although two Japanese locales are supported on AIX, there is just one set of Japanese books that is used for both these locales.

6. If you have installed IBM Tivoli NetView Clients, configure Client/Server access.

Refer to "Configuring Client/Server Access" in the *Tivoli NetView for UNIX Configuration Guide* for information on how to configure Client/Server access.

**Note:** Client and server systems must be set to the same codeset. They must also be on the same platform (heterogeneous client/server between AIX and Solaris is not supported for the Language Kits).
LANG and LC_ALL Environment Variable Settings

You must have the LANG and LC_ALL environment variables set to the appropriate locale in your current session when you start the IBM Tivoli NetView native Console or any other IBM Tivoli NetView applications. The following table lists the supported LANG and LC_ALL environment variable settings for each codeset and platform:

<table>
<thead>
<tr>
<th>Codeset</th>
<th>AIX</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japanese EUC</td>
<td>ja_JP</td>
<td>ja</td>
</tr>
<tr>
<td>Japanese Shift JIS (AIX only)</td>
<td>Ja_JP</td>
<td>Not supported</td>
</tr>
<tr>
<td>Korean EUC</td>
<td>ko_KR</td>
<td>ko</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>zh_CN</td>
<td>zh</td>
</tr>
</tbody>
</table>

Upgrading from a Previous Tivoli NetView Language Kit

If you upgrade from Version 6.0.* with the Language Kit to Version 7.1.2 with the Language Kit you might have to update any customizations you made to the language files.

Migrating Security Files

The IBM Tivoli NetView Security Registration Files are not migrated when upgrading from a previous version of IBM Tivoli NetView. Any user modifications to the standard IBM Tivoli NetView security registration files, located in the following directories, will not be migrated:

/usr/OV/security/$LANG/Domains/registration
/usr/OV/security/$LANG/Domains/SrAdmin

These files will have to be manually modified. The old versions of these files will be located in your backup directory. The sample Oper group security registration files are no longer provided for the Language Kits. To create these files for the Oper group, use the nvsec_admin application to Copy from the SrAdmin group and then modify the permissions of menus and applications to which you wish to limit access.
If NetView Applications or Web Consoles Display in English

There are some restrictions in IBM Tivoli NetView on the information that is translated. Refer to the "Translation Support" section for more information.

On Solaris, applications that are run on the IBM Tivoli NetView server and are displayed on the client, such as the SNMP Configuration window, will display in English. Please see the "Client/Server" section for more information on this problem.

If you experience other problems displaying IBM Tivoli NetView applications in the desired language, follow these steps to troubleshoot and fix the problem:

1. Stop all IBM Tivoli NetView graphic applications on the server and any clients.

2. Check that the following environment variables are set correctly in your current session and for the root user on both the IBM Tivoli NetView client and server:
   - NLSPATH - this variable must contain the following string before any language specific directories or cat files:
     `/usr/lib/nls/msg/%L/%N:/usr/lib/nls/msg/%L/%N.cat`
   - XUSERFILESEARCHPATH - this variable must contain the following string:
   - LANG and LC_ALL must be set to the correct codeset (as listed in the codeset table on the previous page). Use the locale command to display the current values.

The following system files can affect variable settings for all users:

- `/etc/profile`
- `/usr/OV/bin/NVenvironment`
- `/etc/environment` (AIX only)
- Files in the `/etc/default` directory (Solaris only)

The NLSPATH and XUSERFILESEARCHPATH variables can become very large if you have scripts running in your shell that are continuously...
appending to the existing path. If this occurs, these variables may become unusable by the shell, causing application text to be displayed in English. If you notice that either of these variables has an extremely long path list with duplicates, reset the variable to eliminate duplicate entries from the path list, and run scripts that append to these variables in your .profile or .login file instead of your .kshrc or .cshrc script.

3. Check that the system environment is set correctly on the IBM Tivoli NetView client and server.

   On AIX, check that the cultural convention, language, and keyboard are set to the correct codeset using SMIT (Manage Language Environment...Change/Show Primary Language Environment).

   On Solaris, check that the LANG and LC_ALL environment variables are set to the correct codeset in the /etc/defaults/init file.

4. If you made any changes to system files in Step 2 or 3 above, you need to reboot the machine so these changes will take effect.

5. If Steps 1 through 4 did not fix the problem, then you may be inadvertently starting the IBM Tivoli NetView daemons in the English locale by using the Tivoli Framework to stop and start the daemons, or perform other administrative tasks that restart the daemons. The Server Setup application (serversetup) is the recommended method for restarting the daemons and other administrative tasks. You can also use SMIT on AIX. Use the ovstatus nvsecd command to determine whether the daemons are starting in English. If the “last message” field for the nvsecd daemon is displayed in English, they are being started in English.

   If the daemons are starting in English, use these steps to restart them in the correct locale:

   • On AIX only, stop and restart the inetd daemon:

     stopsrc -s inetd
     startsrc -s inetd

   • Stop and then restart the IBM Tivoli NetView daemons:

     /usr/OV/bin/ovstop
     /usr/OV/bin/ovstop nvsecd
     /etc/netnmrc (AIX)
     /etc/init.d/netnmrc (Solaris)
Installation Utility Scripts

The following utility scripts are provided in the TOOLS directory on the IBM Tivoli NetView language support CD-ROM:

<table>
<thead>
<tr>
<th>Script Name</th>
<th>Used to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>deinstall.ja_euc</td>
<td>Deinstall the NetView Japanese EUC client or server kit and books</td>
</tr>
<tr>
<td>deinstall.ja_sjis</td>
<td>Deinstall the NetView Japanese Shift JIS client or server kit and books</td>
</tr>
<tr>
<td></td>
<td>(AIX only)</td>
</tr>
<tr>
<td>deinstall.ko</td>
<td>Deinstall the NetView Korean client or server kit and books</td>
</tr>
<tr>
<td>deinstall.zh</td>
<td>Deinstall the NetView Simplified Chinese client or server kit and books</td>
</tr>
</tbody>
</table>

Language Kit Restrictions

This section describes restrictions and known problems for the IBM Tivoli NetView Language Kits.

Client/Server

Heterogeneous client/server between AIX and Solaris is not supported for the Language Kits.

Remote X display is not supported between AIX and Solaris because of font incompatibilities.

The IBM Tivoli NetView client, server, and Web console systems must be set to the same language and codeset. Running the IBM Tivoli NetView client and server in mixed languages is not supported. It will result in corrupted characters appearing in the maps and menus, and some of the functions in the Web Console will not work.

To display IBM Tivoli NetView applications on a remote X display, the system on which the application is being displayed must also have the appropriate
locale installed and set. Otherwise, garbage characters will appear in the maps and menus.

On Solaris, applications that are run on the Tivoli NetView server and are displayed on the client, such as the SNMP Configuration window, will display in English. These applications will display correctly translated on the server for Solaris, and will display correctly on both the client and server for AIX. This problem will be fixed in a future maintenance release.

**Problem Starting Daemons from the Tivoli Desktop**

When you start the IBM Tivoli NetView daemons from the Tivoli Desktop, they will be started in the English locale. The workaround is to start the daemons using the Server Setup application (you may also use SMIT on AIX) or from the command line using the `/etc/netnmrc` (AIX) or `/etc/init.d/netnmrc` (Solaris) scripts with the correct locale set. The Server Setup application (or SMIT on AIX) is the recommended method of performing administrative tasks.

**Translation Support**

Programmer commands and functions, advanced administrative tasks, information primarily used by Tivoli Support for problem diagnosis, and SNMP data (which is by its nature English only) are not translated or enabled.

The following information is not translated:

- Base and Language Kit installations
- API definitions, man pages, command line utilities and program samples
- Database field names and enumerated values
- Map, submap and snapshot names
- SmartSet names and descriptions
- Symbol class/subclass names and status values
- MIB object names, descriptions, and enumerated values
- Trap names and descriptions
- Event Source, Event Attributes, and Agent values
- Administrative support scripts used by Server Setup, Client Setup and SMIT are not fully translated
• NetView configuration menus in the Tivoli Framework
• Files in the /usr/OV/conf/$LANG directory, except for explore.conf
• Tracing and logging messages, with the exception of some messages in the /usr/OV/log/netview_<user>.log file
• Copyright screen and on-line help for the MLM Configuration Application
• The default Role names in Web Console Security
• There are no translated versions of the MLM

The following applications are not DBCS enabled:
• The Agency Policy Manager (APM) and SmartSet Editor are translated but are not DBCS enabled. SmartSet names, descriptions, and other information entered in these two applications must be English text.
• The Ruleset Editor is translated but not DBCS enabled. Event attributes and other field names must be entered in English.
• The Locate window supports multi-byte characters for exact matching but not when using regular expressions.
• The File -> View Report application, which is launched from the Event Display, is not DBCS enabled. You cannot view reports created using File -> Create Report that contain multi-byte characters.
• Map, submap, and snapshot names must be entered in English for all NetView windows. Multi-byte names are not supported.

**Language Kit Notes**

This section provides general product information for the Language Kits.

**On-line Help and Books**

You must install the IBM Tivoli NetView Books 7.1.2 component and the specific language IBM Tivoli NetView books component in order to use the on-line books.

The following books are translated:
Web Browser Configuration for use with the IBM NetView Web Console

If you are using the Netscape Communicator or Navigator to access the Tivoli NetView Web Console, you will need to configure the following settings in Netscape:

- Specify the font to use for the Unicode encoding, Edit -> Preferences... Appearances... Fonts
- Select the UTF-8 character set, View -> Character Set -> Unicode (UTF-8)

For more information on these settings, refer to the URL http://home.netscape.com/eng/intl/basics.html

If you are using Internet Explorer, follow these steps to configure the fonts:

- Select Tools -> Internet Options... Fonts, then select from Language script list, and choose a corresponding Web page font and Plain text font. If the page still doesn’t display correctly, select View -> Encoding -> Unicode (UTF-8).

Monitor Resolution

It is important to have a monitor with the appropriate resolution (as specified in Tivoli NetView Release Notes Version 7.1). The recommended dimensions are 1280 x 1024 pixels or higher. If you display NetView on a monitor with a lower resolution, the text and windows will be very large.

Using NetView Security

You must have the correct locale set in your current session when invoking nvauth to log into security, or nvsec_admin to perform security
administration tasks. Use the `locale` command to determine your current locale settings.

If your locale is not set to the appropriate language codeset, you will not be able to log into security using `nvauth`. The `nvsec_admin` application uses the current locale to determine which set of users, groups, and security registration files to modify.

### Ping Tool Information in Wrong Panel with non-English AIX

On AIX, the IBM Tivoli NetView `ping` tool may display regular command output in the panel reserved for error messages. This has been noticed especially for Korean and Chinese AIX locales and appears to be related to a defect in the behavior of the operating system-provided ping utility.

### Chinese Character Display Problems under Solaris

Under Solaris 8, certain Chinese characters (for example, the double-byte dash character) cannot be displayed correctly in the IBM Tivoli NetView Web Console. This applies to input as well as display fields. This problem has not been observed on other platforms using the same Web Console code and appears to be related to the Solaris JRE implementation.

### Xcolormap Exhaustion in UNIX Environments

In all UNIX environments, Xcolormap exhaustion may lead to display problems when running the IBM Tivoli NetView application since NetView shares X colors with other X applications. As a result, menu labels under the mouse cursor may become illegible because of diminished contrast between highlight color and menu label text.

This problem is especially noticeable on AIX.

You can avoid this problem by making sure that IBM Tivoli NetView is started *prior to* any other color-intensive X applications, such as Netscape Communicator.

### Font Quality Issues with Web Console

The JREs for all platforms for which the NetView application offers National Language Support use font settings which may result in the use of unattractive fonts in non-English environments.
To overcome this problem, IBM recommends the use of its World-Type font set. Please contact your customer representative for information on how to obtain WorldType fonts and how to configure your JRE to use these fonts.

**IBM Tivoli Enterprise Console Language Kit Compatibility**

If you are forwarding events to a version of the IBM Tivoli Enterprise Console that is earlier than version 3.7, follow the above procedure to add the following required flags:

- Set the **Pre37Server** flag to **YES** in the /usr/OV/conf/tecint.conf file by adding the entry **Pre37Server=**YES.

- Set the **Pre37ServerEncoding** flag to the Tivoli encoding at the event server. See the Tivoli Management Framework User's Guide for additional information about Tivoli text encoding support.

After adding these flags you must stop and restart the nvserverd daemon by typing:

```
/usr/OV/bin/ovstop nvserverd
/usr/OV/bin/ovstart nvserverd
```
## Appendix A:
### Event Mapping and New Class Structure

Table 1 shows the events that are forwarded by default.

<table>
<thead>
<tr>
<th>ClassName</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>OV_IF_Deleted</td>
<td>58785793</td>
<td>IDEL_EV</td>
</tr>
<tr>
<td>Interface deleted</td>
<td></td>
<td></td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td>OV_Unmanage_IF</td>
<td>50790442</td>
<td>UI_EV</td>
</tr>
<tr>
<td>Interface unmanaged</td>
<td></td>
<td></td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_STATUS</td>
<td>OV_IF_Down</td>
<td>58916866</td>
<td>IUP_EV</td>
</tr>
<tr>
<td>Interface Up</td>
<td>NEW</td>
<td>58916867</td>
<td>IDWN_EV</td>
</tr>
<tr>
<td>Interface Down</td>
<td>NEW</td>
<td>58916866</td>
<td>IASD_EV</td>
</tr>
<tr>
<td>Interface Unreachable</td>
<td>NEW</td>
<td>58916970</td>
<td>IUNREACH_EV</td>
</tr>
<tr>
<td>TEC_ITS_ISDN_STATUS</td>
<td>NEW</td>
<td>58916982</td>
<td>IBUACTIVE_EV</td>
</tr>
<tr>
<td>ISDN Active</td>
<td>NEW</td>
<td>58916983</td>
<td>IBUDORMANT_EV</td>
</tr>
<tr>
<td>ISDN Dormant</td>
<td></td>
<td></td>
<td>ACTIVE DORMANT</td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td>OV_Node_Deleted</td>
<td>58785795</td>
<td>NDEL_EV</td>
</tr>
<tr>
<td>Node deleted</td>
<td></td>
<td></td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td>OV_Unmanage_Node</td>
<td>50790419</td>
<td>UN_EV</td>
</tr>
<tr>
<td>Node unmanaged</td>
<td></td>
<td></td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NODE_STATUS</td>
<td>OV_Node_Down</td>
<td>58916864</td>
<td>NUP_EV</td>
</tr>
<tr>
<td>Node Up</td>
<td>OV_Node_Down</td>
<td>58916865</td>
<td>NDWN_EV</td>
</tr>
<tr>
<td>Node Down</td>
<td>OV_Node_Down</td>
<td>50790400</td>
<td>NM_EV</td>
</tr>
<tr>
<td>Node Marginal</td>
<td></td>
<td></td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_ROUTER_STATUS</td>
<td>NV_Router_Status</td>
<td>58916971</td>
<td>ROUTDOWN_EV</td>
</tr>
<tr>
<td>Router Down</td>
<td></td>
<td>58916972</td>
<td>ROUTUNREACH_EV</td>
</tr>
<tr>
<td>Router Unreachable</td>
<td></td>
<td>58916973</td>
<td>ROUTERUP_EV</td>
</tr>
<tr>
<td>Router Up</td>
<td></td>
<td>58916974</td>
<td>ROUTMARG_EV</td>
</tr>
<tr>
<td>Router Marginal</td>
<td></td>
<td></td>
<td>DOWN MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_SNMPCOLLECT_THRESHOLD</td>
<td>OV_DataCollectThresh</td>
<td>58720263</td>
<td>DCOL_EV</td>
</tr>
<tr>
<td>SNMP Collect threshold exceeded</td>
<td>OV_DataCollect_Rearm</td>
<td>58720264</td>
<td>DCRRA_EV</td>
</tr>
<tr>
<td>SNMP Collect re-arm threshold</td>
<td></td>
<td></td>
<td>THRESHOLD EXCEEDED</td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_CONNECTIVITY</td>
<td>NV_Subnet_Reachability</td>
<td>58916968</td>
<td>NETUNREACH_EV</td>
</tr>
<tr>
<td>Subnet Unreachable</td>
<td></td>
<td>58916969</td>
<td>NETREACH_EV</td>
</tr>
<tr>
<td>Subnet Reachable again</td>
<td></td>
<td></td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REACHABLE_AGAIN</td>
</tr>
</tbody>
</table>
NOTE: TEC_ITS_SA_STATUS events are also forwarded by default. See documentation for the optional IBM Tivoli Switch Analyzer product for more information.

Table 2 shows event mappings and new class structure for events not listed in Table 1.

Table 2: Mappings between Events and New Class Structure

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_APPLICATION_ALERT</td>
<td>NV6K_Application_Alert</td>
<td>59047936</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_APPLICATION_STATUS</td>
<td>NV6K_Application_Up_Event</td>
<td>5919056</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>NV6K_Application_Down_Event</td>
<td>5917905</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_BAD_SUBNET_MASK</td>
<td>OV_Bad_Subnet_Mask</td>
<td>58982414</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_IF_SEGMENT</td>
<td>OV_Chg_IF_Segment</td>
<td>50790427</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_NETMON_RETRY_COUNT</td>
<td>NV6K_Change_Netmon_Retry_Count</td>
<td>59179070</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_POLLING_PERIOD</td>
<td>OV_Change_Polling_Period</td>
<td>50790411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CMIS_EVENT</td>
<td>OV_CMIS_Event</td>
<td>58916870</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CONNECTION_ADDED</td>
<td>OV_Connection_Added</td>
<td>50790409</td>
<td>ADDED</td>
</tr>
<tr>
<td>(Windows Only)</td>
<td>OV_Connection_Deleted</td>
<td>50790410</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_CPU_LOAD</td>
<td>NV6K_Cpu_Load</td>
<td>58720256</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_DISK_SPACE</td>
<td>NV6K_Disk_Space_Percentage_Used</td>
<td>58720257</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_ERROR</td>
<td>OV_Error</td>
<td>58851329</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_Fatal_Error</td>
<td>OV_Fatal_Error</td>
<td>58851330</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FORCED_POLL</td>
<td>NV6K_Forced_Poll</td>
<td>50790412</td>
<td>START</td>
</tr>
<tr>
<td></td>
<td>NV6K_Cancel_Forced_Poll</td>
<td>50790413</td>
<td>CANCELLED</td>
</tr>
<tr>
<td>TEC_ITS_FORW_STATUS_CHANGE</td>
<td>OV_Forw_Status_Chg</td>
<td>58982407</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FORWARDING_TO_A_HOST</td>
<td>NV6K_Forwarding_To_A_HOST</td>
<td>58982408</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_HSRP_ADDED</td>
<td>NV6K_Hsrp_Added</td>
<td>58785796</td>
<td>ADDED</td>
</tr>
<tr>
<td>(UNIX Only)</td>
<td>NV6K_Hsrp_Deleted</td>
<td>58785797</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_IF_CRC_ERROR</td>
<td>NV6K_Interface_CRC_Errors</td>
<td>58720260</td>
<td></td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td>TEC_ITS_IF_DESC_CHANGED</td>
<td>OV_If_Desc_Chg</td>
<td>58982413</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_FLAGS_CHANGED</td>
<td>OV_If_Flags_Chg</td>
<td>50790446</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_DEFERRED</td>
<td>NV6K_Interface_Percent_Derred</td>
<td>58720258</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_COLLISIONS</td>
<td>NV6K_Interface_Percent_Collisions</td>
<td>58720259</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_INPUT_ERRORS</td>
<td>NV6K_Interface_Percent_Input_Errors</td>
<td>58720261</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_OUTPUT_ERRORS</td>
<td>NV6K_Interface_Percent_Output_Errors</td>
<td>58720262</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_POSITION_CHANGED</td>
<td>(Windows Only) NV6K_Interface_Position_Changed</td>
<td>50790447</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_TYPE_CHANGED</td>
<td>OV_If_Type_Changed</td>
<td>58982412</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>OV_If_Added</td>
<td>58785792</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td>OV_Manage_If</td>
<td>50790441</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_MAP_CHANGE</td>
<td>(Windows Only) NV6K_Map_Change_Event</td>
<td>59113474</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_ACTION</td>
<td>(Windows Only) NV6K_Netmon_Action</td>
<td>50790426</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_FILE</td>
<td>(Windows Only) NV6K_Netmon_Change_Trace_File</td>
<td>50790422</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_MASK</td>
<td>NV6K_Netmon_Change_Trace_Mask</td>
<td>50790423</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_NODE</td>
<td>(Windows Only) NV6K_Netmon_Dump_Node</td>
<td>50790424</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_INTERFACE</td>
<td>(Windows Only) NV6K_Netmon_Dump_Interface</td>
<td>50790425</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_ADDED</td>
<td>OV_Network_Added</td>
<td>50790407</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OV_Network_Deleted</td>
<td>50790408</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_FLAGS_CHANGED</td>
<td>OV_Network_Flg_Chg</td>
<td>50790443</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_MANAGE</td>
<td>OV_Manage_Network</td>
<td>50790416</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OV_Unmanage_Network</td>
<td>50790417</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_STATUS</td>
<td>OV_Network_Normal</td>
<td>50790403</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OV_Network_Marginal</td>
<td>50790404</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OV_Network_Critical</td>
<td>58978689</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td>OV_Node_Added</td>
<td>58785794</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_NODE_FLAGS_CHANGED</td>
<td>OV_Node_Flags_Chg</td>
<td>50790445</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td>OV_Manage_Node</td>
<td>50790418</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NO_SNMP_REPLY</td>
<td>OV_No_Snmp_Reply</td>
<td>58982409</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_OBJECT_ID_CHANGE</td>
<td>OV_Object_Id_Chg</td>
<td>58982403</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_CHANGED</td>
<td>OV_Phys_Addr_Chg</td>
<td>58982400</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_MISMATCH</td>
<td>OV_Phys_Addr_Mismatch</td>
<td>58982401</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_ADDED</td>
<td>OV_Segment_added</td>
<td>50790405</td>
<td>ADDED</td>
</tr>
<tr>
<td></td>
<td>OV_Segment_Deleted</td>
<td>50790406</td>
<td>DELETED</td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_FLAGS_CHANGED</td>
<td>OV_Segment_Flag_Chg</td>
<td>50790444</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_MANAGE</td>
<td>OV_Manage_Segment OV_Unmanage_Segment</td>
<td>50790420</td>
<td>MANAGE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50790421</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_STATUS</td>
<td>OV_Segment_Marginal OV_Segment_Critical</td>
<td>50790401</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50790402</td>
<td>MARGINAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58916888</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVER_STATUS</td>
<td>NV6K_Up NV6K_Down</td>
<td>58916964</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58916965</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_POINT_APPL_CHANGED_MASK (Windows Only)</td>
<td>NV6K_Service_Point_Appl_Changed_Mask</td>
<td>59179069</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_STATUS</td>
<td>NEW_NV_Service_Down</td>
<td>58916976</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58916976</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SNMP_DATA_COL_FILE_FORMAT</td>
<td>NV6K_Sys_Data_Col_File_Format</td>
<td>50790440</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SNMP_STATUS_CHANGE</td>
<td>NV6K_Snmp_Status_Change</td>
<td>58916871</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_MASK_CHANGED</td>
<td>OV_Subnet_Mask_Chg</td>
<td>58982406</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_CONTACT_CHANGED</td>
<td>OV_Sys_Contact_Chg</td>
<td>58982410</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_DESCR_CHANGED</td>
<td>OV_Sys_Desc_Chng</td>
<td>58982404</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_LOCATION_CHANGED</td>
<td>OV_Sys_Location_Chg</td>
<td>58982411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_NAME_CHANGED</td>
<td>OV_Sys_Name_Chg</td>
<td>58982405</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRALERT_CHANGE_TRACEMASK</td>
<td>NV6K_Tralert_Change_Tracemask_Event</td>
<td>59179068</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRAP_CONF_FORMAT_CHANGED</td>
<td>NV6K_TRAPD.CONF_Format_Changed</td>
<td>50790438</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_THRESHOLD_CHANGE</td>
<td>NV6K_Set_Threshold NV6K_Delete_Threshold</td>
<td>50790414</td>
<td>SET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50790415</td>
<td>DELETE</td>
</tr>
<tr>
<td>TEC_ITS_UNDETERMINED_LINK_LEVEL_ADDR</td>
<td>NV6K_Undetermined_Link_Level.Addr</td>
<td>58982402</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_WARNING</td>
<td>NV6K_Warnings</td>
<td>50462720</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: nvmaputil Utility

Usage

/usr/OV/bin/nvmaputil

[-h | --help]

[--mapname map_name]

[--delete selection_name1 ... selection_nameN]

[--hide-symbol symbolID1 ... symbolIDN]

[--unhide-symbol symbolID1 ... symbolIDN]

[--hide-interface-and-node ip_address1 ... ip_addressN]

[--unhide-interface-and-node ip_address1 ... ip_addressN]

[--manage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]

[--unmanage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]

[--manage-interface ip_address1 ... ip_addressN]

[--unmanage-interface ip_address1 ... ip_addressN]

[--scopeinfo scope_info_filename]

[--dump-scopes | dump-scope scope_name]

[--dump-definitions <true_or_false>]

[--dump-nodes <true_or_false>]

[--dump-node-interfaces <true_or_false>]

[--dump-interfaces <true_or_false>]

[--dump-router-overlaps <true_or_false>]

[--dump-node-overlaps <true_or_false>]

[--logconfig log4j_config_file]

Where:

-h, --help display this help and exit
### --mapname
- **the currently opened read/write map to use**

### --delete
- **OVwDB selection names for which all associated symbols are to be deleted**

### --hide-symbol
- **mapdb symbol IDs to hide (use ovmapdump to obtain symbol IDs)**

### --unhide-symbol
- **mapdb symbol IDs to unhide (use ovmapdump to obtain symbol IDs)**

### --hide-interface-and-node
- **one or more IP addresses, where each IP address entry results in hiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it's an "isConnector" device)**

### --unhide-interface-and-node
- **one or more IP addresses, where each IP address entry results in unhiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it's an "isConnector" device)**

### --manage-node
- **one or more hostnames or IP addresses, where each one corresponds to a node to be managed**

### --unmanage-node
- **one or more hostnames or IP addresses, where each one corresponds to a node to be unmanaged**

### --manage-interface
- **one or more IP addresses, where each one corresponds to an interface to be managed**

### --unmanage-interface
- **one or more IP addresses, where each one corresponds to an interface to be unmanaged**

### --scopeinfo
- **the ScopeInfo.xml file to use, defaults to the file actively being used by the webserver (/usr/OV/www/conf/ScopeInfo.xml)**

### --dump-scopes
- **dump scope information about all scopes and the in-scope OVwDB objects for these scopes**

### --dump-scope
- **dump scope information for a particular scope and the in-scope OVwDB objects for this scope**

### --dump-definitions
- **if set to "true" the dumped scope information contains scope definitions (default is "true")**
--dump-nodes if set to "true" the dumped scope information shows in-scope nodes (default is "true")

--dump-node-interfaces if set to "true" the dumped scope information shows the set of in-scope interfaces for each in-scope node [only useful if --dump-nodes is passed as "true"] (default is "true")

--dump-interfaces if set to "true" the dumped scope information shows in-scope interfaces (default is "true")

--dump-router-overlaps if set to "true" the dumped scope information shows in-scope router overlaps, where a router is found in more than one scope (default is "true")

--dump-node-overlaps if set to "true" the dumped scope information shows in-scope node overlaps, where a non-routing node is found in more than one scope (default is "true")

--logconfig log4j configuration filename

nvmaputil --hide-interface-and-node 10.42.242.21
Hide the interface symbol whose IP address is "10.42.242.21" and also hide the segment-level node symbol that this interface is attached to (for example, pluto.ma.ibm.tivoli.com). If the node attached to this interface was a connecting device, a node symbol found on a network-level submap might be set hidden as well (only if all interfaces that semantically belong to this network were now set hidden).

nvmaputil --delete sig.ma.ibm.tivoli.com
Delete the node sig.ma.ibm.tivoli.com.

nvmaputil --unmanage-node wopr.ma.ibm.tivoli.com cnatp.rtp.ibm.tivoli.com

nvmaputil --dump-scopes
Dumps out verbose scope information for currently in-use scopes (based on the scopes currently defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --scopeinfo /tmp/ScopeInfo.xml
Dumps out verbose scope information for the scopes defined in /tmp/ScopeInfo.xml (useful if trying to configure appropriate scopes without stopping the webserver to do so).

nvmaputil --dump-scope OurLan

Dumps out verbose scope information for the single scope, OurLan (based on the scopes currently defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --dump-definitions true --dump-nodes false --dump-interfaces false --dump-outer-overlaps false --dump-node-overlaps true

Dumps out all scope definitions and node overlaps for the currently in-use scopes. Network service providers might use a command like this to quickly obtain the misconfigured IP addresses to use as arguments in a subsequent call in which the --hide-node-and-interface option is used.

Examples

The following nvmaputil examples involve two simple scopes, both being defined by a single network. The WestfordLAN scope is composed of network 10.141.242, and the LabLAN scope is composed of network 10.103.2. There are two multi-homed nodes that appear in both networks and, therefore, both scopes. These two multi-homed nodes are ptasillo.ma.ibm.tivoli.com (containing interfaces 10.141.242.70 and 10.107.2.100) and wopr.ma.ibm.tivoli.com (containing interfaces 10.141.242.71 and 10.107.2.12).

This example dumps the scope information for the WestfordLAN:

```
/usr/OV/bin>nvmaputil.sh --dump-scope WestfordLAN
Scope : WestfordLAN
Scope Definition
Resolved In Scope Networks
  Network[1] : 10.141.242 (517) (Network Address: 10.141.242.0)
Resolved In Scope Nodes
```

Resolved In Scope Interfaces

Resolved In Scope Router Overlaps
Resolved In Scope Node Overlaps
Overlapped Scope : LabLAN
OverlappedInterface[1] : 10.107.2.100 (564)
OverlappedInterface[1] : 10.107.2.12 (566)

This example dumps the scope information for the LabLAN:

```
/usr/OV/bin>nvmaputil.sh --dump-scope LabLAN
Scope : LabLAN
Scope Definition
Resolved In Scope Networks
Resolved In Scope Nodes
Hostname[1] : 10.107.2.140 (1047)
Interface[1] : 10.107.2.139 (1064)
Interface[1] : 10.107.2.155 (1054)
```
  Interface[1] : 10.107.2.3 (1040)
  Interface[1] : 10.107.2.1 (1038)
  Interface[2] : 10.107.2.5 (1050)
  Interface[1] : 10.107.2.100 (564)
  Interface[1] : 10.107.2.12 (566)

Resolved In Scope Interfaces
Interface[1] : 10.107.2.1 (1038)
Interface[2] : 10.107.2.3 (1040)
Interface[3] : 10.107.2.5 (1050)
Interface[5] : 10.107.2.100 (564)
Interface[8] : 10.107.2.155 (1054)

Resolved In Scope Router Overlaps
Resolved In Scope Node Overlaps
Overlapped Scope : WestfordLAN

The following example dumps out all scope definitions and node overlaps for the currently in-use scopes.

/usr/OV/bin>nvmaputil.sh --dump-scopes --dump-definitions true --dump-nodes false --dump-interfaces false --dump-router-overlaps false --dump-node-overlaps true
Scope: LabLAN
Scope Definition
Network[1]: 10.107.2 (563)
Resolved In Scope Networks
Network[1]: 10.107.2 (563) (Network Address: 10.107.2.0)
Resolved In Scope Node Overlaps
Overlapped Scope: WestfordLAN
NodeHostname[1]: ptasillo.ma.ibm.tivoli.com (522)
OverlappedInterface[1]: 10.141.242.70 (521)
NodeHostname[2]: wopr.ma.ibm.tivoli.com (528)
OverlappedInterface[1]: 10.141.242.71 (527)

Scope: WestfordLAN
Scope Definition
Network[1]: 10.141.242 (517)
Resolved In Scope Networks
Network[1]: 10.141.242 (517) (Network Address: 10.141.242.0)
Resolved In Scope Node Overlaps
Overlapped Scope: LabLAN
NodeHostname[1]: ptasillo.ma.ibm.tivoli.com (522)
OverlappedInterface[1]: 10.107.2.100 (564)
NodeHostname[2]: wopr.ma.ibm.tivoli.com (528)
OverlappedInterface[1]: 10.107.2.12 (566)